A Step-By-Step Guide to converting .dwg CAD files to GIS shapefiles

Using AutoCAD 2002 and ArcGIS 8.3

NPS Spatial Data Specifications:
http://science.nature.nps.gov/nrgis/standards/docs/GISSpecs31105_final.pdf
CAD TO GIS:
A Step-By-Step Guide
to converting
.dwg CAD files to
GIS shapefiles
Using AutoCAD 2002 (AutoDesk) and ArcGIS 8.3 (ESRI)

Produced by:
National Park Service
Northeast Region GIS
15 State Street
Boston, Massachusetts

in cooperation with:
University of Rhode Island
Environmental Data Center
Kingston, Rhode Island

September 2005
Revision 1d

Note:
Reference by NPS to particular software products or formats is to facilitate technical understanding of the data conversion process and is not intended to constitute an endorsement of such product by the NPS or the federal government of the United States.
As the nation's principal conservation agency, the Department of the Interior has responsibility for most of our nationally owned public lands and natural and cultural resources. This includes fostering wise use of our land and water resources, protecting our fish and wildlife, preserving the environmental and cultural values of our national parks and historical places, and providing for the enjoyment of life through outdoor recreation. The department assesses our energy and mineral resources and works to ensure that their development is in the best interests of all our people. The department also promotes the goals of the Take Pride in America campaign by encouraging stewardship and responsibility for the public lands and promoting citizen participation in their care. The department also has a major responsibility for American Indian reservation communities and for people who live in island territories under the administration of the United States of America.

The National Park Service cares for special places saved by the American people so that all may experience our heritage.

*Experience your America™*
Contents

Introduction 07
• Purpose 07
• Need for the CAD-GIS Guide 07
• Primary Issues with CAD-GIS conversion 08
• Software notes 10

Part One: Readying CAD drawings for GIS conversion 11

Part Two: Creating GIS data from CAD files 15
• Step 1: Adding CAD files to a Dataview 15
• Step 2: Exporting CAD data as Shapefiles 16

Part Three: Aligning Data in GIS 17
• Procedure 1: Defining the Projection 18
• Procedure 2: Reprojecting Shapefiles to UTM NAD83 18
• Procedure 3: Spatially Adjusting Shapefiles in ArcGIS 19

Part Four: Simplifying Shapefiles 23
• Creating new shapefiles from CAD layers 23
• Creating GIS polygons from CAD line data 25

Appendices
Appendix A: Recommended CAD specifications to prepare data for conversion to GIS format 27
Appendix B: Special procedure to convert CAD annotation to GIS using a geodatabase 28
Appendix C: List of Preparers 30
Introduction

Purpose
All spatial data, or digital map data of any kind, developed by or for the NPS should meet the NPS Spatial Data Specifications (SDS), available at http://science.nature.nps.gov/nrgis/standards/docs/GISSpecs31105_final.pdf. This CAD-GIS Conversion Guide describes a step-by-step process for clean and accurate conversions of Computer Aided Drafting (CAD) "".dwg" files to Geographic Information System (GIS) shapefiles ".shp", one of the critical elements of the NPS SDS. The process was developed over several months by the National Park Service Northeast Regional Office in Boston in conjunction with the Environmental Data Center at the University of Rhode Island. The team used CAD drawings and GIS data from several National Park Service units including Statue of Liberty National Monument and Ellis Island, Sagamore Hill National Historic Site, and Governors Island National Monument. Planners and park staff at each of these sites used products resulting from this study to help make important management decisions.

Need for the CAD-GIS Conversion Guide
With the growing popularity of GIS and the increasing availability of a wide range of datasets, GIS is becoming a common tool for all disciplines of the National Park Service. In park planning specifically, GIS can be a useful tool for analysis of landscape changes and trends, and can help managers and the public visualize resource conditions and the consequences of proposed management actions.

Often, accurate GIS data representing large-scale landscape or architectural features of parks does not exist. What usually is available, however, is a collection of project-oriented construction drawings from previous projects at the site (sometimes referred to as "legacy" data). Since the 1980s, much of this work has been produced in digital form as Computer Aided Drafting (CAD) drawings. These digital drawings are typically very accurate to a large scale (1"=40' to 1/8" = 1') and are often based on a ground survey of the site done by a certified professional surveyor. By turning these CAD drawings into GIS data, the full functionality of GIS can be used to analyze and compare the data from the CAD drawing with other GIS data. There are alternative ways to work with CAD data in GIS. This document focuses on the most robust and long-term solution for CAD data conversion. At the completion of this process the final output files are in a GIS format and fully usable in all GIS operations.
Recent advances in GIS software have made it easier to transfer CAD drawings into GIS shapefiles or geodatabases, but many quirks still exist in file transfer due to the inherent differences in the file formats. With this project, the NPS developed a step-by-step method of transfer, noted issues in both the CAD and GIS to be aware of when attempting to convert CAD data into GIS format, and created GIS-friendly guidelines for outsourcing new CAD work. This document is intended to be a guide, and as such cannot address every technical issue and possible scenario in CAD to GIS transfers. Websites have been listed throughout the document and Appendix C has additional NPS contacts should you need more assistance.

This document will be updated as software changes, and as new information and methods become available. Please see Appendix C for where to direct your comments and suggestions.

**Primary Issues with CAD-GIS conversion**
CAD drawings and GIS data are created for different purposes, and as a result the softwares' data models are inherently different, and the files differ in their construction and attributes. These issues will be addressed in our step-by-step guide for CAD-GIS conversion.

*Drawings vs. Spatial Databases*
CAD drawings are simply that - drawings - and contain no additional attributes. All CAD drawing elements are either points, lines, or polylines (made up of a continuous string of lines). A CAD drawing element contains only the information needed to draw itself - lineweight (thickness), linetype (continuous, dotted, dashed), color, and the layer (explained below) to which it is assigned. GIS, on the other hand, has an additional functionality - its features can hold enormous amounts of data describing the features (that is, a polygon representing a house could contain information about the owner, street address, numbers of bathrooms, bedrooms, etc). Also, GIS data is "spatially informed" regarding adjacency and other spatial relationships. Simply put, CAD is a drawing, and GIS is a spatial database.

*CAD Layers*
CAD features are organized by layers, which can contain points, lines, polygons, and annotation (as compared with a GIS shapefile, which can only contain one feature type). Each drawing feature belongs to a specific layer. In this way, elements of similar type can be viewed, hidden, frozen, moved, and edited together. An example is
a layer named “TREE” that contains all the elements representing trees in the CAD file. When a CAD drawing is exported to a GIS shapefile, the CAD drawing’s layers become a field in the GIS shapefile’s attribute table. New point, line, and polygon shapefiles can then be extracted based on each layer (trees, buildings, roads, etc).

Since there is no accepted naming convention for CAD layers and restrictions on the length of layer names, it's often difficult for a new user to decode a CAD layer name. For example, the layer name LA-TR-DE could mean a deciduous tree under the category "landscape". Another difficulty is many CAD drawings contain layers that are not sufficiently "clean", meaning stray pieces of lines or points that belong to one layer could appear on a completely unrelated other layer, or remnants of lines or points used in the development of the drawing but not representative of actual features could remain (trim lines, transit points, etc). These inconsistencies are not of major concern in the CAD realm, but in GIS it introduces inaccuracies and can corrupt the database.

**Coordinate Systems**
CAD drawings are usually much more accurate to a large scale than GIS data, but often use different coordinate systems than GIS. For most NPS GIS data, the standard coordinate system and datum is Universal Transverse Mercator (UTM) NAD 83, whereas the standard CAD survey coordinate system is State Plane. Sometimes a CAD drawing will have no recognizable coordinate system, which usually means the drawing uses an arbitrary, locally established point of origin (0,0). Using ArcGIS, the CAD data can be reprojected into a new coordinate system or, if there is no known coordinate system, the CAD data can be aligned manually, by spatial adjustment. Identifying a CAD drawing’s coordinate system is very important for a clean transfer to GIS.

**Documentation**
Since CAD drawings are only drawings, it is often difficult to determine the author, purpose, sources, extents, accuracy, and other important information about the drawing. Creating complete documentation on a CAD drawing’s purpose and technical history or creation is an essential step toward meeting the metadata component of the NPS Spatial Data Specifications. Undocumented data cannot be shared, distributed, or considered and treated as part of the park database.
Creating GIS Shapefiles from CAD layers
When a CAD drawing is imported into GIS, the GIS will interpret all elements into the four categories of GIS features: points, lines, polygons, and annotation (text). Typically it will be desirable to further divide these shapefiles based on the original CAD layers. For example, three separate shapefiles could be created from the three CAD layers Trees, Roads, and Buildings.

The following flow chart illustrates the methodology used in this step-by-step guide.
Cleaning up CAD drawings for GIS
This section, completed in AutoCAD, will ensure that the CAD file is properly documented and in the best shape to be transferred to GIS. Lacking AutoCAD, the user should record all information available about the CAD file (see Step 2 below) and skip to Part Two. CAD commands are noted in *ITALIC UPPER CASE*. See the AutoCAD Help menu for more information.

In AutoCAD, open the drawing and follow these steps:

**Step 1**
**TURN ON AND ZOOM OUT**
Before beginning, be sure that all layers are turned on and the entire drawing extents are viewable.

To turn all layers on: click the **Layers** button . In the **Layers Properties Manager** box, beside each layer, a lightbulb icon will identify whether a layer is turned ON or OFF. Click any dark lightbulb (layer OFF) to make it yellow (layer ON).

To zoom to the drawing extents: Command Line: **ZOOM <enter>**, **Extents <enter>**

**Step 2**
**RECORD DRAWING INFORMATION AND BEGIN METADATA DOCUMENTATION**
Record all information available regarding the drawing’s author, technician, source, name, scale, date, surveyor, coordinates, extents, layer names and descriptions, horizontal level of accuracy, etc. This information should then be recorded in the subsequent GIS shapefile’s metadata document, following Federal Geographic Data Committee (FGDC) guidelines. Much of this information may be shown in the drawing’s titleblock or notes. Contacting the creator and/or surveyor of the drawing will also yield good information. Also note any missing information.

For more information on FGDC metadata standards, visit: [http://www.fgdc.gov/metadata/contstan.html](http://www.fgdc.gov/metadata/contstan.html)
**Step 3** RENAME CAD FILE
Save the file under a new name before editing, so the original is not modified.

**Step 4** DETERMINE YOUR DATA NEEDS
Depending on project needs, it may or may not be desirable to transfer the entire CAD drawing to GIS. If there is interest only in a few layers of CAD data (trees, roads, buildings, for example), and the remaining CAD data does not need to convert to GIS, use the following method. Select only the layers you wish to transfer to GIS, and copy them into a new CAD drawing to be taken into GIS. By selecting only the elements on these layers and copying them to a new drawing, all unnecessary drawing elements will be left behind. Follow the steps below precisely, otherwise significant errors may result.

Procedure:
Step 1: Isolate a desired layer. The Express Tools extension will isolate the one layer. Lacking this extension, click the Layers button. Right click any layer and choose Select All layers. Click the lightbulb icon next to a layer name to turn OFF all layers. Turn back ON the layer to be isolated. Now only the selected layer is shown.
Step 2: Under the Edit pulldown menu, choose Copy with Base Point.
Step 3: Specify a base point of 0,0.
Step 4: Select all objects to be copied and press <enter>.
Step 5: Paste into the new drawing, specifying an insertion point of 0,0.

Repeat these steps for each layer you wish to transfer to GIS.

These steps will result in a new drawing composed of only the elements and layers chosen for GIS transfer. Use this new drawing to convert the CAD data to GIS.
**Step 5** **ERASE UNWANTED ELEMENTS**
Using the `ERASE` command, delete all unwanted drawing elements - titleblocks, borders, legends, etc. Only the pertinent drawing elements to be transferred to the GIS database should remain. Note: information in the titleblock and/or legends may be essential to record in the subsequent shapefile's metadata. Keep good records.
Command line: `ERASE`, `<select objects>`, `<enter>`.

**Step 6** **RENAME CAD LAYERS**
Many times CAD developers will code their layer names in a way that makes them difficult to decipher. Rename layers in CAD as needed for clarification. Click the **Layers** button. Slowly double-click the layer name and type a new name.

**Step 7** **CLEAN CAD LAYERS**
Before transferring the CAD drawing to GIS, verify that all features are on their respective layers. Isolate each layer by turning all other layers OFF and see that there are no stray drawing elements or features that belong on other layers (see Step 4). `ERASE` those elements that do not belong on the layer, or cut and paste them into their proper layer. Repeat for all the layers in the drawing.
(Note: Layer 0 and "defpoints" are inherent in all CAD drawings. These layers cannot be deleted, but should contain no objects.)

**Step 8** **DETERMINE CAD COORDINATE SYSTEM**
Many CAD drawings, especially survey drawings, are drawn to a real-world coordinate system that GIS will recognize. When a CAD drawing is drawn to a standard coordinate system (State Plane, for instance), it can be reprojected in GIS for proper alignment with other GIS data. If the drawing has no standard coordinate system, it must be spatially adjusted in GIS to align with other data. Spatial adjustment is usually less accurate than reprojecting.
The CAD file’s coordinate system may be noted on the drawing itself, in the titlebock, in the drawing notes, or on a layer showing a GPS point of origin. If there is no information on the coordinate system and datum from the drawing or the creators, compare drawing coordinates in CAD with GIS coordinates of the same area using a georeferenced orthophoto or other dataset. You will need this information to correctly align the data within GIS.
Compare coordinates of identical areas in CAD and GIS.
PART TWO  Creating GIS data from CAD files

This section requires ArcMap and ArcCatalog.

Step 1  Begin Metadata Documentation
Record all information available regarding the CAD drawing’s author, technician, source, name, scale, date, surveyor, coordinates, extents, layer names and descriptions, horizontal level of accuracy, etc. This information should then be recorded in the subsequent GIS shapefile’s metadata document, following Federal Geographic Data Committee (FGDC) guidelines. Much of this information may be shown in the drawing’s title-block or notes. Contacting the creator and/or surveyor of the drawing will also yield good information. Also note any missing information.

For more information on FGDC metadata standards, visit: http://www.fgdc.gov/metadata/contstan.html

Step 2  Add CAD files to a Dataview
CAD drawings can be immediately displayed in ArcGIS. This step does not create GIS data, it only displays CAD data in the GIS dataview.

In ArcMap, add the CAD .dwg file to be converted, using the Add Data button. When browsing for the CAD file, two files of the same name will appear. The first, displayed as a light-blue icon, is a “CAD feature data set”, which will convert the CAD file into point, polyline, polygon, and annotation objects (Polygons are created from CAD’s closed polylines. Annotation is created from CAD text). The second, displayed as a white icon, is the simple CAD line drawing. In this file, text and polygons will read as linework only, and there will be no associated attributes for any objects. To convert CAD files into ArcGIS data (shapefiles or other), choose the first file (light-blue icon).
Step 2  Export CAD data as Shapefiles
When the blue CAD file is added to ArcMap, the file will be divided into data sets, based on the four types of GIS data: point, line, polygon, and annotation. Shapefiles can be created from the point, line, and polygon data sets. The annotation set cannot be exported as a shapefile. Annotation must be exported as a feature class of a geodatabase (see Appendix B).

Right click on each data set and choose Data ➔ Export Data. Export as separate shapefiles. Remember, the resulting shapefiles will not yet have a defined coordinate system in GIS. Choose the default option “Use the same Coordinate System as this layer’s source data.”

Tip 1: Depending on the project, many times it is only necessary to convert the CAD line and polygon data sets to GIS shapefiles (CAD point data is difficult to decipher, and CAD annotation is difficult to work with in GIS and usually does not contain real data, only labeling). Export only the pertinent data sets.

Tip 2: Often, CAD polygons will transfer into GIS as line data. This happens because the CAD developer did not “close” a polyline to create a polygon. This can be corrected in GIS by tracing new polygons over the CAD line data. The procedure is described in Part Four, page 25.
In order for newly created shapefiles to align properly with other GIS data, they need to have a coordinate system/projection defined in GIS. The NPS standard coordinate system for parks is Universal Transverse Mercator (UTM) and the standard datum for parks is NAD83.

To determine if a shapefile has a defined coordinate system, check the original CAD drawing notes, compare coordinates of an identical spot in CAD and GIS, and/or check with the CAD drawing developer (see Part One, Step 8).

Another method to determine the coordinate system: add a shapefile to a blank ArcMap document and right-click on the shapefile name. Select "Properties" under the context menu and click on the "Source" tab. Check here to see if a coordinate system has been defined.

If the shapefile's coordinate system is UTM NAD83, there is nothing more to do, it is projected correctly. Otherwise, there are three possible procedures:

- If it lists a coordinate system other than UTM NAD83, the shapefile must be reprojected to UTM NAD83 using ArcToolbox's Project Wizard (Procedure 2).
- If it has an undefined projection, it must be defined as UTM NAD83 using ArcToolbox's Define Projection Wizard (Procedure 1) and then spatially adjusted to align properly, using ArcMap's Spatial Adjustment extension (Procedure 3).
- In some cases, the original CAD drawing was created using a defined coordinate system but ArcGIS is not recognizing it. In this case the projection must be defined as such using ArcToolbox's Define Projection Wizard (Procedure 1) and then the shapefile reprojected to UTM NAD83 using ArcToolbox's Project Wizard (Procedure 2).
**Procedure 1**

**Defining the Projection**

Use this procedure if the original CAD drawing was created using a defined coordinate system, but ArcGIS is not recognizing it.

To define a shapefile's coordinate system, open ArcToolbox and select the Define Projection Wizard (under Data Management Tools → Projection) for shapefiles (see illustration on Page 17). Follow the directions of the Wizard to define the coordinate system interactively. Select the projection and specify its parameters. Browse to the input shapefile.

Enter in the original coordinate system the CAD drawing was created in. Next, use the Project Wizard to reproject the shapefile from its current coordinate system to UTM NAD83 (Procedure 2).

If you have no knowledge of the CAD drawings coordinate system, choose UTM NAD83 and spatially adjust the shapefile (Procedure 3).

**Procedure 2**

**Reprojecting Shapefiles to UTM NAD83**

Use this procedure when the coordinate system of the shapefile has been defined, but is not UTM NAD83. Using the Project Wizard in ArcToolbox (see illustration on Page 17), project the data to UTM NAD83. Be sure to specify NAD83 and the appropriate UTM zone for your park. Finally, specify a shapefile name for the newly projected shapefile. FGDC compliant metadata can now be written for the shapefile and these data can be used in your GIS.

For more information on projections, visit:

www.aquarius.geomar.de/omc/omc_project.html
Spatially Adjusting Shapefiles in ArcGIS

Use this procedure when the shapefile’s coordinate system has been defined in GIS but the data is not aligning properly with other data. This process will move a shapefile from its current coordinates to the correct coordinates by aligning control points in the shapefile with identical control points from a correctly projected orthoimage or other dataset of the same geographic area.

Before spatially adjusting the shapefile, its projection must be defined as UTM NAD83. Follow the instructions in Procedure 1 to define the projection, and then continue.

**Step 1**  
Be sure the Spatial Adjustment extension is loaded in ArcMap.

**Step 2**  
In a blank ArcMap project, open a correctly georeferenced orthoimage or other dataset suitable for serving as a planimetric base for georeferencing the newly created shapefiles. Be sure it is projected to UTM NAD83. There should be common elements visible in both the CAD shapefiles and the orthoimage (corners of building, edge of road, manholes, etc). These common elements will act as the control points for adjustment. Make sure both the Editor and Spatial Adjustment toolbars are visible. Check to make sure that the data frame is in the correct projection (UTM NAD83, in the correct zone for the project).

**Step 3**  
Add one of the shapefiles created from the CAD drawing, preferably the polyline or line shapefile. This file type is preferred because it often has the best features that can act as control points (for example, street intersections and building corners).
**Step 4** Click "Start Editing" on the Editor toolbar and choose the proper folder that contains the shapefile you wish to adjust. Under the Spatial Adjustment pulldown menu, select “Set Adjust Data”, check the layer to be adjusted, and select "All Features in These Layers."

**Step 5** On the Spatial Adjustment toolbar, use the New Displacement Link button to insert displacement links connecting common features from the shapefile to the target orthophoto (or other dataset).

- First, click the New Displacement Link button to activate the process.
- Next, click a strategic spot on the shapefile.

**Tip 1:** Use the corners of buildings, manholes, or other easily identifiable points that have likely been ground-checked by the CAD developer and aren't subject to inconsistencies. Use a number of points from various locations across the drawing so that the resulting reprojection is not weighted to be more accurate in one portion of the drawing than another.

**Tip 2:** You will be able to use all the pan and zoom functions while creating displacement links. A good tip is to set two view "Bookmarks" (under the View pull-down menu) for easy navigation, one for the shapefile and one for the target orthophoto.

- The next click should be the identical spot on the target orthophoto.
- Repeat this process, inserting links as evenly as possible throughout the drawing.

**Step 6** When satisfied that enough links have been established, click the Spatial Adjustment toolbar and select Links→ Save Links File. In this way identical links can be applied to the remaining shapefiles from the CAD drawing.
Step 7 Under the **Spatial Adjustment** pulldown menu, choose an “Adjustment Method”. When possible, select the “Similarity” transformation. This method maintains the aspect ratio because it does not differentially scale or skew your data. If this algorithm does not perform well, select the “Affine” transformation. However, the Affine transformation will differentially scale, skew, rotate, and translate data. The remaining adjustment methods are often too aggressive to be useful for CAD data adjustments.

Step 8 Now the spatial adjustment can be executed. Select **Adjust** from the **Spatial Adjustment** pulldown menu to move the shapefile to its new location and complete the spatial adjustment. If the links do not result in a satisfactory match with the orthophotos, click **Undo** from the **Edit** pulldown menu and repeat Steps 5 and 6, deleting links with high residual errors and/or adding new links in certain areas.

Step 9 When a satisfactory match has been achieved, select “Stop Editing” from the **Editor** toolbar and save edits when prompted. The shapefile is now properly aligned with other UTM NAD83 data! Remember to save your links again if you have changed them. Record your overall RMS/residual error and Adjustment Method to include in your metadata later.

Tip 3: Avoid applying multiple spatial adjustments to a shapefile. It is best to spatially adjust only once, and redo the adjustment if it is not satisfactory.
Spatially adjusting the remaining shapefiles
The remaining shapefiles created from CAD data can now be spatially adjusted by using the same displacement links created for the first shapefile.

Step 10 Add the remaining shapefiles to be adjusted to the Dataview.

Step 11 Repeat Steps 3 and 4 from the previous section (“Start Editing” and “Set Adjust Data”). In the Set Adjust Data dialog box, make sure that all of the shapefiles that are to be adjusted are selected.

Step 12 Under the Spatial Adjustment pulldown menu, click Links and choose Open Links File. Select the links file created from the previous shapefile adjustment.

Step 13 Under the Spatial Adjustment pulldown menu, choose the same “Adjustment Method” used for the first shapefile.

Step 14 Select “Adjust” on the Spatial Adjustment pulldown menu. Select “Stop Editing” from the Editor toolbar and save edits when prompted. All of the CAD shapefiles are now aligned with other UTM NAD83 data!
CREATING NEW SHAPEFILES FROM CAD LAYER NAMES
When a CAD drawing is converted to a GIS shapefile, the original CAD layers become a field in the shapefile’s attribute table (see Introduction and Part One for more information on CAD layers). By selecting objects in the shapefile based on their CAD layer names, and exporting them as new shapefiles, shapefiles can be created for each original CAD layer. Therefore, this procedure can yield separate shapefiles for grouped objects (trees, buildings, roads, etc) which can then be integrated more effectively into a GIS database.

The original CAD drawing’s layers are now located in a field called “Layer” in the shapefile’s attribute table.
Step 1 In ArcMap, with the shapefile loaded, choose “Select By Attributes” from the Selection pulldown menu.

In the Select by Attributes box, choose the target shapefile you wish to convert, and “create a new selection” based on the Layer field (the Layer field is the original CAD layer for each object). Apply the query and all objects in that shapefile with that particular layer type will be selected.

Step 2 With the cursor over the shapefile name the Table of Contents view, right-click and choose Data→Export Data. Export the selected features as a new shapefile.

Step 3 Repeat steps 1-2 for each layer you wish to convert to a separate shapefile.

With ArcView 3.3
For those with access to ArcView 3.3, a free Extension is available from ESRI ArcScripts: Split Shapefiles version 1.4 - Jeff Jenness, this extension takes a single shapefile and breaks it up into multiple separate shapefiles based on a common attribute value. For example, splitting a shapefile containing building footprints and sidewalks, into two separate files.

By installing this extension with ArcView 3.3 and by adding the shapefile created from the AutoCAD DWG file, the converted shapefile can be split into multiple shapefiles using the AutoCAD field “Layer”. The result is a shapefile for each unique CAD layer, such as sidewalk or building.
CREATING GIS POLYGONS FROM CAD LINE DATA

Sometimes, objects that appear as polygons in CAD will transfer to GIS as line data. Using the Trace Tool on the Editor toolbar in GIS, new polygons can be traced from line data.

**Step 1** Add to the dataview the line shapefile from which the new polygons will be traced. Add the polygon shapefile to which the new polygons will be added. If there is no current polygon shapefile, create a new polygon shapefile in ArcCatalog and add it to the dataview.

**Step 2** Under the Editor toolbar, choose “Start Editing.” If prompted, choose the folder which contains the shapefiles to be edited. Also on the Editor toolbar, set the Task to “Create New Feature” and the Target to the polygon shapefile.

**Step 3** Using the Editor’s Selection Tool, select the lines to be traced into a polygon. Hold the <shift> key when selecting to make multiple selections, but only select one polygon at a time.

**Step 4** Using the Editor’s Trace Tool, click sequential vertices of the selected lines to form a polygon. To complete the polygon, right-click and choose “Finish Sketch”.

**Step 5** Repeat Steps 3 and 4 until all polygons have been created.

**Step 6** When all polygons have been created, choose “Stop Editing” in the Editor toolbar, and save the edits. New polygons have now been created from CAD line data.
Conclusion
The CAD data are now wholly converted to a GIS format!

The remaining steps to adding the files to the Park GIS database include completing the metadata, adding the steps above as “process steps.” NPS spatial data must meet the *NPS Spatial Data Specifications* (SDS), available at [http://science.nature.nps.gov/nrgis/standards/docs/GISSpecs31105_final.pdf](http://science.nature.nps.gov/nrgis/standards/docs/GISSpecs31105_final.pdf), regardless of whether the data starts as GIS or CAD format.
Appendix A: Recommended CAD specifications to prepare data for conversion to GIS format

These simple steps will ensure easier transfer to GIS, and proper GIS metadata documentation.

1. All work completed in the proper NAD83 State Plane coordinate system for the project area.

2. The drawing contains the following information:
   - Company name, address, and phone number.
   - The name and internal reference number for the drawing.
   - The location of the drawing (address, town, state).
   - The date the drawing was completed.
   - The time period the drawing represents.
   - Sources of original survey or other sources that informed the CAD drawing.
   - The coordinate system, scale, and direction of the drawing.

3. A detailed list of layer names and their meanings are included.

4. Layers are organized to contain only the objects which pertain to the layer, with no extraneous objects or stray elements.

5. The drawing is PURGED thoroughly of unused layers, blocks, linetypes, and other material.

6. All linework that represent outlines of buildings or objects are to be closed polygon entities (P-line vectors) created in model Space with seamless edges preventing overlapping or crossing vector features, to allow for transfer to polygons in GIS.
Appendix B: Special procedure to convert CAD annotation to GIS

Unlike the point, line, and polygon feature classes of CAD drawings, CAD annotation cannot be exported as a shapefile. GIS considers only point, lines, and polygons to be editable spatial objects. To work around this, CAD text can be made editable in GIS by converting it to an annotation feature dataset within a geodatabase, using the Convert Coverage Annotation button.

The steps to accomplish this, detailed below, are:
1) define a spatial reference for the CAD drawing, in order for the new annotation to scale correctly.
2) create a geodatabase with a new annotation feature dataset that is linked to the spatial reference of the CAD drawing.
3) create a feature class that will house the converted annotation
4) convert the CAD annotation to the feature class using the Convert Coverage Annotation button.

**Define a spatial reference for the CAD drawing**

Many CAD files are created using an arbitrary coordinate system tied to the origin point. For the purposes of converting annotation, it is necessary to define a spatial reference for the CAD drawing, and save it as a projection file that can be referenced by the feature dataset that will house our annotation.

1. In ArcCatalog navigate to the CAD drawing whose annotation layer you wish to convert to GIS.
2. Right-click the file and choose Properties.
3. Click the “Spatial Reference” tab (see inset).
4. If the Spatial Reference is "Undefined", click the Edit button.
5. In the “Spatial Reference Properties” dialog box, click Select, choose a predefined coordinate system, and click Add. The stan-
dard NPS projection is UTM NAD83. Choose the proper zone for the project.

6. Now we must save this spatial reference. Click the **Save As** button.
7. Navigate to the folder where the CAD file is located, and type a name for the coordinate system file using the same prefix as the CAD file and click **Save** (example: for a CAD drawing named NPS100.dwg, the projection file should be called NPS100.prj)
8. Click **OK** in the “Spatial Reference Properties” dialog box.

### Step 2 Create a personal geodatabase and feature dataset for annotation

1. In ArcCatalog create a new personal geodatabase (set inset).
2. Create a feature dataset inside of the geodatabase that will house the annotation. When defining the Spatial Reference for the new feature dataset, click the **Import** button and navigate to the CAD file. This will import its spatial reference, which was defined in the previous step.
3. Create a new annotation feature class inside of the feature dataset. The reference scale and units do not seem to have an effect on the conversion, so long as the reference scale is greater than 1.

### Step 3 Convert CAD annotation to a feature class

1. In ArcMap, add the CAD drawing, of which annotation will be one layer.
2. Using the **Convert Coverage Annotation** tool, convert the CAD annotation to geodatabase annotation. Geodatabase annotation is preferred because it can be easily shared.
   - Click on the **Convert Coverage Annotation** tool.
   - Click the **Into a Database** radio option and browse for the new annotation feature class which was just created in ArcCatalog.
   - Click the **Convert** button. The annotation can now be added to the **ArcMap** interface.

The “Convert Coverage Annotation” tool is located in **Tools** → **Customize** → **Commands** (tab) → **Label**.
Appendix C: List of Preparers

Justin Berthiaume, Landscape Architect
National Park Service
Northeast Regional Office
15 State Street
Boston, MA 02109
617.223.5135
Justin_Berthiaume@nps.gov

Roland Duhaime, Research Associate
Environmental Data Center
University of Rhode Island
Coastal Institute Building
Kingston, RI 02881
401.874.5406
Roland@edc.uri.edu

Dennis Skidds, Research Associate
Environmental Data Center
University of Rhode Island
Coastal Institute Building
Kingston, RI 02881
Dennis@edc.uri.edu

Nigel Shaw, Northeast Region GIS Coordinator
National Park Service
15 State Street
Boston, MA 02109
617.223.5092
Nigel_Shaw@nps.gov

Other contributors:

Cheryl Sams O’Neill, NPS
Andy Steele, NPS
Bill Slocumb, NC State
Brian Aviles, NPS

For more technical assistance, check with your Regional GIS Coordinator.